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Section 1: Setup 

1.1 System Description 

The AID EliSpot Reader System is a computer-based system for the semi-automatic 

interpretation of 96 well EliSpot plates. Designed for routine usability, giving 

reproducible results in very little time. This allows the user to turn EliSpot into a 

standard laboratory application. The system works with all standard micro titer plates 

with a well diameter of 5.8 mm. It can also be set up to read low-volume plates with a 

well diameter of 2.5 mm or ELISA-style plates with a slightly bigger well diameter. 

The AID EliSpot Reader is equipped to read, interpret and digitally store EliSpot data. 

Since different types of  EliSpot assay give characteristic spot patterns, dedicated 

settings for each cytokine or assay type are implemented and can be both modified 

and selectively applied by the user. 

The AID EliSpot Reader consists of a Reader Unit that reads the wells in the plate, 

and a Computer/Control Unit that is connected to the Reader. The Reader Unit 

contains a high-end video camera and a 2-axis scanning stage which positions the 

wells in the camera view. 

The Computer/Control Unit consists of a PC equipped to run the Reader Unit. Recent 

models have a FireWire host controller card and operate the stage through a serial or 

USB port connection. 

The AID EliSpot Reader System also includes a monitor and a printer and a network 

card for online-support. An uninterruptible power supply, a bar code scanner or more 

parts may be supplied by AID as well; see the separate technical manuals for these 

parts. Do not replace any of these items without first contacting AID, as this may 

impair system performance. The Computer/Control Unit has often been used to run 

other equipment not supplied by AID, e.g. ELISA Readers. AID will assume no 

responsibility for this and warranty will be impaired. 

Different Reader Systems are available from AID. For details refer to the Reader 

section 6. 
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1.2 Setup 

The AID EliSpot Reader System  will usually be set up by a company representative. 

If you need to set up the system on your own, read the system description 

subsection. When moving the machine always remember to secure the stage of the 

Reader Unit with the screws or plugs provided to avoid serious damage to the 

Reader. If the equipment has been stored in the cold or damp, wait a few hours for 

the equipment to reach room temperature. Check if all cables are in proper condition 

without bends or faulty insulation. Check all equipment for visible damage. Check 

equipment against original quotation, order and packing list. Connect power cables 

first, then plug in keyboard, mouse, monitor and printer. At this point it is a good idea 

to boot and check if monitor and printer work. Switch off Computer/Control Unit again 

and connect to Reader Unit.  

Test entire EliSpot Reader System: Check if all cables are in proper condition without 

bends or faulty insulation. Check all equipment for visible damage. Check equipment 

against original quotation, order and packing list. Check serial numbers of equipment 

against QC documents or packing list. Undo stage screws. Test-read one or several 

plates, adjusting stage, camera and count settings accordingly. Use AID EliSpot 

Master (e.g. No. 33) to demonstrate functionality if available. Save plate documents. 

Transfer plate folders onto CD-ROM for reference. If necessary, connect the 

Computer/Control unit to network. 
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Section 2: Software Features 
The AID EliSpot Software is controlled through pull-down menus and context or pop-

up menus. In addition the most frequently used functions are provided as icons in the 

toolbar. Note that the menus and toolbars differ depending on the view.  

This section will describe the main menu bar from left to right.  

 

2.1 The File Menu 

All general functions of the software like creating, loading, saving and printing of 

plates are located in the File Menu.  

 

 

 

 

2.2 The View Menu 
 
In this menu you have the choice whether you want to activate the toolbar, the status 

bar and/or the Data bar. 

 

The status bar is located on the bottom of the application‟s main window. Here 

messages about the status of the application are displayed. It is divided into three 

parts, the left most is intended for common messages, the right one contains 



 

AID EliSpot Reader Handbook V7.x 8/73 

Autoimmun Diagnostika GmbH  

Ebinger Str. 4 

D-72479 Strassberg 

Germany 

Tel. +49-743493640 

Fax  +49-7434936440 

www.aid-diagnostika.com 

 

 messages about stage movement and camera acquisition, and the middle contains 

messages about counting. When you run Auto  

Read + Count, the state of image acquisition will be displayed on the right, while the 

state of the counting thread is displayed in the center. You may notice that 

sometimes counting takes longer than acquiring the images, so the counting thread 

may still be running after all images have already been acquired. This is especially 

the case if your computer system has less then 512 MB working space. In this case 

please contact your AID representative and ask for RAM upgrade. 

 
The Data Bar is located on the left side of the program window. It allows you to 
switch between several well-information at one sight. 
 
The toolbar is located at the top of the Program window and contains the most 

frequently used functions as icons.  

 

 
 

 

You will also be able to customize the toolbar for different users. This is useful if 

users with limited rights are working with the system. Select "customize toolbar" and 

enable/disable selected buttons of the toolbar. 

"Data Set >>" is available only if you are using an AID iSpot Fluorescent reader. 

Clicking on this point will display the different pictures taken by the machine with 

different filters (e.g. FITC, Cy3 or Cy5) 
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2.3 The Selection Menu 

 

This heading allows you to work either with individual wells or groups of wells. By 

marking the wells (click with left Mouse button, hold down mouse, pass over wells), 

section of the plate can be selected. 

 

 

 

 

Clear:   deselects all selected wells 

Invert:   inverts the selection 

Select All:  selects all wells of the plate 

2.4 The Run Menu 
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2.4.1 Running the Reader System 

Under the Run menu you will find functions to read, count and analyze a whole plate. 

In most cases you will do reading and counting in one step, however sometimes it 

may be necessary to separate the reading and counting of a plate. To read and count 

with AutoCenter use the Read+Count Plate command or press the GO button in the 

toolbar.  If you have disabled the AutoCenter function in the calibrate stage menu you 

can run AutoCenter at this point.  

 

 

 

2.4.2 Analyse Plate 

If you have defined an AID plate layout together with rules you can analyse the plate 

according to the selected rules. For this select “Analyse plate” in the Run menu. 

Results will be displayed in the information area of the one well view.  Reading, 

counting and analysing is possible with the appropriate command in that menu or 

with the “RCA” button in the toolbar. 

 

 

2.4.3 Re-Count Directory 

This submenu allows the user to recount a number of plates which are already stored 

on the hard disk. The user will be asked for the location of folder which contains the 

plates on the hard disk and will then select a target folder for the recounted plates. 

The software will automatically load the plate, count the plate under the selected 

settings and store the new plate in the selected folder. This function is useful if you 

decide  to change count settings and need to reanalyze a large number of plates. 
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 2.5 The Tools Menu 

This menu harbours all tools which are necessary to adjust the AID reader and to set 

up the software according to user‟s needs. 

  

 

 

2.5.1 Camera settings 

Under this menu the user is able to change various settings of the camera. The 

appearance of the dialog box depends on the camera type of your EliSpot Reader 

system. If you select Show Preview you will see the current view of the camera. 

While reading a plate you can see moving the counting stage in real-time. You can 

alter the size of the preview. Under the Change Color setting menu there are 

various possibilities to change the settings of the camera. This dialog box is strongly 

dependent on the type of camera, for example ELR04 machines have a Allied 

camera and the following dialog pops up. AID recommend using the settings shown 

as a starting point. If your EliSpot reader carries a different camera type ask for a 

separate documentation on this. 
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2.5.2 Stage settings 

If you hold the mouse over the word Stage in the tool menu a sub menu will appear, 

showing all options to handle the stage of the EliSpot Reader. 

Reset the stage 

With the reset function you can reset the stage. The stage will move in its upper right 

position. This will take a few seconds. Since the software automatically controls the 

stage reset you will normally not need this function. However, a reset may be useful 

in case of an unusual behavior of the stage. 

 Calibrate stage 

The dialog box for calibrating the stage is explained in more detail under  

Load calibration 

If you decide not to use the default calibration file “stage.ini” you can load a different 

calibration file. This will import another calibration file from the user's own settings.  

Save calibration 

Usually a calibration file will be saved directly from the calibrate stage dialog box. 

However, you may decide to save the file from the file menu. 

Eject plate 

By selecting “eject plate” the stage will move towards the user so you can easily 

change a plate. Clicking “eject plate” once more will cause an opposite move of the 

stage. This button also triggers a stage reset when you next read a plate. 
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 2.5.3 Count settings 

There is a wide variety of different EliSpot-assays, and even in one lab different plate 

types may be used. It will therefore be necessary to predefine settings and to use 

them while interpreting EliSpot assays. This is possible under the Count settings 

dialog box. Here you can create, edit and delete settings and store them under 

selected names. 

 

 

 

To create new settings press the New button. You can derive settings from existing 

ones by marking the source settings from the list before you click the New button. 

First, you will be asked for the name of the new settings. After you have entered the 

name the new settings will appear in the list box. (This may require closing and 

opening of the dialog box). If you do not select particular settings from the list, the 

default settings will be taken as source for the new ones. 

The Edit button allows making modifications to the new settings at this stage. For this 

make your changes in the dialog box and press the Save button. 
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This is one of the most important dialog box in the EliSpot software (See also the 

appendix "ViruSpot" for ViruSpot settings). Here you can set and choose all basic 

settings for interpreting your data. Adjustments can be made on size, intensity and 

gradient of the spots. Select Minimum and Maximum values for spots. Enable Min to 

count all spots with the same or higher intensity, size, or gradient than the selected 

value. Min is selected as a default. Enable Max to count all spots which have a lower 

value than selected.. 

 

 

 

Use Min and Max to define a range of objects to be counted as spots. 

Hit Save to save changes permanently; hit Save As to create new settings based on 

the what you see, leaving the original settings intact; Hit apply only if you have 

changed the emphasis/type of algorithm (this will recount) but hitting Apply is not 

necessary if you have changed cut-offs. 
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Minimum/Maximum values (Intensity) 

Sets the Intensity (darkness) threshold for counting spots. To be counted, a spot 

must have this difference between the intensity of the peak of the spot and its 

surrounding background. The intensity of spots is measured in brightness Units 

relatively to the background. The brightness ranges from 0 (White) to 255 (Black). 

For an IFNγ-assay a value of about 20-25 is an acceptable starting point. However 

individual settings are mostly dependent on the assay and the user‟s choice. 

 

Minimum/Maximum values (Size) 

Sets the minimum size in pixels that an object needs to have to be recognized as a 

spot. Any object that is smaller than this value will not be considered as a spot. The 

value ranges from 1 to 1000. For an IFNγ-assay a value of about 50 is an acceptable 

starting point. However, as for the intensity, individual settings are hardly dependent 

on the assay and the user‟s choice. 

The size of single spots will be calculated to in square 1/100th millimeters (0.01 mm²). 

One square millimeter equals 10.000 square 1/100th millimeters. Please note that 

these are approximate values that may need correction (see section 1.5) 

 

Min/Max Gradient 

The gradient function is a further parameter for characterizing spots. The intensity of 

a true EliSpot nearly follows a Gaussian distribution, with a maximum of intensity in 

the middle and decreasing intensity towards the edges. The gradient value is the 

angle (0° to 90°) defined by a tangent from the maximum of intensity to the 

background intensity. The higher the value for the gradient, the greater will be the 

difference of intensity between the middle of the spot and the edges. 

Enable Min if you want to count all spots with the same or any higher value then the 

selected. This is also the default selection. Enable Max if you want to count spots, 

which have less value than the selected. Use Min and Max to define a range of 

objects to be counted as spots. 
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Emphasis Settings 

Here the user can define whether very small spots (e.g. IL-10 producing cells) are 

expected or very big spots (e.g. B-cells). There is a selecting range from “tiny” over 

“small” and “big” to “huge”. The correct setting depends on the particular assay. A 

good starting point is always the “small” setting. Due to a new algorithm since version 

3.0 (Algorithms A and C) the background enhancement is not needed anymore. 

If users want to calculate with the algorithm from previous versions, they have to 

choose the “Algorithm B”, which was used in versions 2.5-2.9. As a result the Fuzz 

filter, the Filter White Rings (which we recommend should be off at all times) and the 

Background Enhancement will again be available. Please notice, that AID does not 

recommend using these old algorithms and will therefore not support this version any 

longer. However, it may be that users want to profit from the new software's general 

features but continue to use these algorithms e.g. for long-term studies. For 

additional information on the algorithms A-C please use the help button on the right 

hand side of the algorithm combo-box. 

 

Invert Recognition 

Most EliSpot assays will lead to dark spots on a bright background (membran). 

However, some assays - such as those on ELISA-style plates or fluorescent assays 

will result in bright spots on a dark background. Enable the checkbox "Invert 

Recognition" in such cases. 

 

TNTC (too numerous to count) 

In very dark wells such as positive controls with PHA, the spot count result may be 

too low. This leads to a misrepresentation of results in Excel sheets. To counter this, 

you need to determine the level of saturation at which a well is still reliably counted. 

This will depend on the type of assay and very much on the type of color reaction you 

use. Put this value in the TNTC-dialog, wells over this limit will be marked with a red 

mask as saturated. For more details please refer to the appropriate "How to...", which 

you can find under the help menu of the AID software. 
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Count Speed 

This button is available if you are using an AID EliSpot XL system. You may decide 

to use the highest resolution available or you may want to read the plate with lower 

resolution but higher speed. 

 

Classification 

This is an analytical function which allows spots to be classified according to various 

criteria. The spots can be classified according to size (large and small spots), 

intensity, gradient or further criteria of your choice. Note the separate “two-color-

Assay” button that is specialized for separation of red and blue spots (see also 

section 2.5.3.6) 

To use the classification function, you first have to create spot classes. This is done 

by using the Create New Spot Class field. A dialog box appears, in which the class 

name can be entered. The new spot class will appear in the list box in the left of the 

dialog box. To ascertain the characteristics of the spot class click the Select 

Measurement button. A dialog box will appear which allows the criteria for selecting 

spots to be differently weighted. The software is given priorities, by which criteria a 

spot is delegated to a certain class. Thus, if you want to create two spot classes, 

which differ in their size, enable Size and put the weight selector to 100% as shown 

on the picture. 

 

Once you have done the settings for your classes, mark a spot class in the spot class 

Dialog field, open a well of choice and click on the typical spots on your plate (in the 

well). The software will count these spots and “learn” the characteristics. The button 

Clear all samples will delete the examples of the spots class without deleting the 

spot class itself. To delete the spot class, use the Delete spot class button. 

To see only these spots with specified characteristics in the well press the View 

current class button. As a result the marking crosses will only appear on the spots 

of the selected class. To see all classes once again press the View all classes 
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 button. The results of the spot classification will be displayed in the information list in 

the single well layout. 

Important note: Do not forget to select the View all Classes button after finishing your classification 

assay, since the software will always show the current class if you have once selected this function. 

 

 

Two-color-Assay 

Pressing the two color button will open the following dialog box 

 

 The box is designed to facilitate finding appropriate color settings for blue and red 

spots which are most commonly used in a two-color experiment. For this bring the 

ruler for red in a starting position, hold down the shift key on the keyboard and move 

the ruler to the end position. This will define the range for what you define as red. 

Once ready do the same for the blue color and press apply two-color settings. The 

software will automatically generate three different spot classes for blue, red and 

mixed-colored spots.  

Note: 

AID recommends using an AID iSpot Fluorescent Reader when planning two-color 

assays.   
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2.5.4 countAID 

This function will help you to determine the optimal count settings for a given EliSpot 

plate. To do this first select some typical wells of the plate, then hit the countAID 

button and follow the instruction. At the end of this fully automatic count setting 

determination the software will recommend the optimal settings for the plate.  

The function will especially help new users the find good settings for a plate, however 

AID strongly recommends to generally find best settings manually, since an algorithm 

will never be able to replace your own opinion.  To find out more about this function 

please refer to "How to find count setting", which you can find under the help menu of 

the AID software. 
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2.5.5 Plate Layout and Rule Compiler 

Layouts are used to insert external data pertaining to, for example, patient ID, cell 

type and number and type of used cells, antigen characteristics, capture-antibody, 

controls etc. into an particular EliSpot assay. Layouts also carry the possibility of 

enabling user-defined rules via a rule compiler, which allow the software to 

automatically rule a test result as reactive/positive (valid) or non-reactive/negative 

(not valid). Layouts and rules are created in specialized dialog boxes, which can then 

be saved, loaded or imported, depending on the situation. Once a layout is created it 

is recommended to save it under the folder "D:\Layouts".  

Creating plate layouts 

 Layouts can be created in the following dialog box, which you will get upon clicking 

on “Plate Layout” within the tools menu. 

 

On the left side of the dialog box you will find 8 combo-boxes were you can enter 

data to describe a particular well(s).  Each combo-box can hold up to 10 different 

user defined entries. The button with the blue “AID” sign will overwrite all user‟s entry 
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 in the combo box “Well type” with AID defined well types such as “positive control, 

negative control etc.”. Please note that when using the Rule compiler you will need 

exactly this terms, otherwise the software will not recognize the type of a well. The 

button with the red cross will delete entries of the combo-boxes. Note that the 

decision which combo-box will be flushed depends on the focus position at that time. 

This means that if the cursor is for example in the “Cytokine antibody” combo-box all 

entries and information about cytokine antibodies will be deleted.  

The “Apply all.” button is used to enter data from several different combo-boxes into 

several selected wells at the same time. Use caution when using this button since it 

may overwrite correct information with incorrect data under some circumstances. We 

suggest only this button at the beginning of preparing a layout when you are sure that 

all data of the selected wells are the same. For example the cell-types, the cell 

numbers and the cytokine antibody are often the same in a plate. 

The other “Apply…” button changes its inscription depending on the focus position of 

the cursor. For example if you are in the “Well type” combo box the button‟s 

inscription will be “Apply well type” whereas if you are in the antigen combo-box the 

inscription will change to “Apply antigen type”. After each entry use this button in 

order to enter data in selected combo boxes for selected wells.  

Once having made your entries in the combo boxes you can add rules to that layout. 

Do so by hitting the „Rule compiler“ button on the right side of the dialog box.  

For more information on preparing a layout please refer to the Top Issue “How to 

prepare a layout” which you can find under the Help menu of the software.  

 Using the rule compiler 
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In this dialog box you will be able to define the result comment of the wells on your 

plate depending on the number of counted spots. On the upper side of the dialog box 

you first should decide whether you want the software to calculate on the basis of 

spot counts, spot forming units or cytokine release (activity).  

Enter all values for negative/positive controls and for the samples, then close the 

dialog field by pressing the OK button. The rules are linked to the layout and can be 

saved together with it. Save the layout/rules combination by going to “File  Save 

plate as layout..” and save preferably under d:\layouts.  

For more detailed information please refer to the Top Issue section of the software  

(Help --> Top Issues --> How to... --> How to create layouts.” 
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 2.5.6 Quality Control  

Click on “System QC test” if you want to perform a quality control of your lightning 

sytem with an AID masterplate. 

Click on „QC setttings“ if you wish to change the AID default settings for your 

masterplate. 

For a detailed description of the QC possibilities please refer to the Top Issue „How 

to perform a quality control“ which is provided under „Help --> Top Issues --> How 

to..“. 

 

2.5.7 Options 

The Options dialog box allows you to set some general adjustments of the system 

and to manage the users working with the system. Note that in older versions of the 

software (<V4.0) the Option dialog could be found under the “File” menu. 

The option “software mode" allows to run the software under different modes, ranging 

from very stringent security settings, which you might need in a clinical trial, to 

moderate settings if there is no need to fullfill such stringent security settings. 

 

 

 

Other things which can be set up in the option menu are the data export, the 

information display and other parameters. It is mentionable that all these settings are 
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 strictly user dependent, which means that each user can set up the system according 

to his wishes and needs.  

A detailed description of what can be customized can be found in  the Top issues file 

“How to customize the software”. 

 

AutoCenter 

As there is some tolerance in the scanning stage and only the wells in the corners of 

the plate (A1, A12 and H12) are calibrated precisely- the coordinates of wells in 

between are interpolated- some of the wells appear slightly “off”. The AutoCenter 

function compensates this misalignment. The settings are already optimized by AID. 

The AutoCenter function is switched on or off in the Calibrate Stage menu. Note: 

you can also run AutoCenter after reading from the Run menu. Switch off AutoCenter 

if you run difficult to read or ELISA-style plates. 

Maximum growth: This function edits the counting area (Area of Interest, AOI)  if the 

selected counting ring is too small. This can happen if the EliSpot plate is bent so 

that the apparent well size is smaller than expected. The default value is 30 %. 

Maximum shrinking: This function edits the counting area (Area of Interest, AOI)  if 

the selected counting ring is too big. This can happen if the EliSpot plate is bent so 

that the apparent well size is bigger than expected. The default value is 10 %. 

Maximum position change: This function defines the search area if the AOI is not 

where the stage calibration expects it. The default value is 50 %. 

Select correction method: According to the plate type, it may be useful to select 

different correction methods. By default the “find any ring shaped structure” is 

selected. 

Factory settings: Restore the AID settings for the AutoCenter function. Note that the 

AutoCenter dialog box is only visible if you are logged in the program as a user with 

supervisor status. 

 

 

Hardware settings 
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The Factory Hardware Presetting specifies your hardware settings like type of 

camera and type of stage motor control. These settings must be made according to 

the hardware you use. The System will not run if the settings in this dialog are wrong. 

This dialog box is usually locked, so settings cannot be changed. 

 

 

File I/O 

 

Select the type of graphic format for your wells under File format for saved images. 

You can choose between JPEG, TIFF or Windows Bitmap. By default a JPEG format 

is selected, since this format will provide high quality pictures of your wells, 



 

AID EliSpot Reader Handbook V7.x 26/73 

Autoimmun Diagnostika GmbH  

Ebinger Str. 4 

D-72479 Strassberg 

Germany 

Tel. +49-743493640 

Fax  +49-7434936440 

www.aid-diagnostika.com 

 

 nevertheless with little disk space required. You can also change the Compression 

level of the JPEG files. A high value will generate pictures with high quality and more 

disc space than a low value. By default the setting is 95 so one picture of a single 

well will require about 50-60 KB, depending of the number of spots. A standard 

resolution plate will occupy about 5-6 MB under these circumstances. 

If you wish to save the count settings together with your plate, than enable the count 

setting function. This is especially useful if you are not using the user management of 

the AID software and will allow you to restore the latest default count settings of a 

saved plate. The count settings used will also be visible in the plate history so you do 

not need this function for documentation purposes. Note that the File I/O dialog box 

is only visible if you are logged in the program as a user with supervisor status. 

 

 User Profiles (User Management) 

 

(also available with the button ) 

The AID EliSpot software is equipped with a user management, so that every single 

user will have his personal settings. The following data are user-specific: 

 Count settings 

 Camera settings (only fire wire camera systems) 

 Camera focus (only ELR04 systems and higher) 

 Stage calibration 

 Display options 

 Layout and rules settings 
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Create new user 

In order to generate a new user a logged on user can select the create new user 

button and enter a username and a password (optional) for the new user in the dialog 

box. This new user will now be added to the user list. By default the new user will 

only have limited possibilities to handle to software, e.g. this user will not be able to 

change any settings. 

To have full access the new user must have supervisor status. Only another user 

with supervisor access can give this status. Once such a supervisor user is logged in, 

he can select the new user by clicking in the user list and edit the user profile. The 

new user will now have the rights to change all settings. 

A user with supervisor status may decide that a new user should only have limited 

rights to handle the software. For this he or she  will be able to choose the allowed 

actions for the new user by clicking the relevant option boxes (see picture below). 

Some software versions will have two more boxes to check: protected mode for 

clinical trials and log-in on start-up. 

 

 

Delete user 

As active user with supervisor status, you can delete other users. You need to 

confirm the deleting. 
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 Change password 

Any user can change his own password. For this they must be logged in and must 

know the old password. No user will be allowed to change the another user's 

password. 

 

Edit user profile 

Any user with supervisor access has the right to alter other users' profiles. Note that 

you will not be able to change your own profile. Each user can be assigned to a 

specific group with different rights to use the software. These groups are called 

"Supervisor, Advanced user and User" (Three level user management). 

 

 

Set default user 

A user with supervisor status can set a selected user as the default user, e.g. the 

user who will be automatically logged in on program startup. This user will not need 

his password to start the program. Only available if the option "User ID and 

password for starting the program" is disabled. 

 

Log in as a user 
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 There are different ways to log in as a user. You can either select your name in the 

user list under the user manager dialog box and press log in or you can click on the 

button in the toolbar. In any case the software will log off the current user and log in 

the new user. A password may be required at this step. 

Every user will have their own count settings, calibration and (depending on the 

system) camera settings. 

 

 

 

Protect the software login with a password 

You may decide to protect the login to EliSpot software with a password. For this 

select the box Use User ID and password for starting the program. 

 

 

2.5.8 Import old user profiles 

If you have updated your PC with the new 4.0 version of the software you may wish 

to import user defined settings from your previous version in use. You can do this 

with the import tool of the 4.0 version. The following dialog box will open: 

 

 

 

 

 

 

 

 

 

 



 

AID EliSpot Reader Handbook V7.x 30/73 

Autoimmun Diagnostika GmbH  

Ebinger Str. 4 

D-72479 Strassberg 

Germany 

Tel. +49-743493640 

Fax  +49-7434936440 

www.aid-diagnostika.com 

 

  

 

First select the path of your previous version which can be found under the C-folder 

(e.g. c:/elispot3.x). Then import the profiles which were found by the software with 

the “Import” button. All select settings from your old EliSpot version are now ready to 

use in the version 4.0. 

 

 

2.6 The Data Menu 

The data menu carries all necessary functions for data analysis and presentation. 
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 2.6.1 View, Save and Print Data File 

During each counting session the AID software automatically generates a text file 

which contains data from the plate. The type of data exported can be customized, 

look at the option command in the file menu. Usually data contain general information 

on the plate (e.g. name, date of reading etc.), relevant data of every single well such 

as number of spots, average surface of the spots, intensity of the spots etc. Also all 

well comments appear in this text file. By default this file is saved with the name 

“data.txt” in the plate folder generated by the Software on saving a plate. However, if 

you need to save this file under a different name you may choose the Save data file 

option. By clicking on view data file the MS Text Editor will open the text file.  

 

 

2.6.2 View Layout Data File 

The currently loaded layout can also be inspected as a text file. For this select the 

“view layout data”. As a result the following text file is displayed: 
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2.6.3 Open in Excel 

This option is designed to export data into a MS Excel workbook. If you click on 

“Open in Excel” the data generated by the AID EliSpot Software will immediately be 

transferred to Excel and a diagram based on the EliSpot data will be generated. The 

whole plate will be exported to Excel unless you have selected some wells by clicking 

on them in which case only the data from these selected wells will be transferred. 

The type of data exported can be customized, look at the option command in the 

tools menu.  Most importantly you can select whether data should be exported in list-

format or in a96-well plate format. 

From this starting point you can do several types of analysis in the worksheet. Use 

EliStat or devise your own method of analysis.  
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It is also possible to collect many plates in one Excel sheet. For this use the 

"Accumulate results in Excel"-function. 

2.6.4  Save as Excel Script 

If you are familiar with programming MS Excel macros you may wish to generate an 

excel script of the data to generate their own macros for further analysis with Excel.  

2.6.5 Open Plate with EliStat 

EliStat is a MS Excel based program in which you can export your EliSpot data. Data 

are shown in the same 96-well layout as in the EliSpot software. EliStat is a open 

source program and can be customized according to your needs. For a more detailed 

description of EliStat please refer to the separate documentation. 

2.6.6 Save as dBase File 

This option is useful if you would like to transfer your data in a professional database 

like MS Access. The EliSpot software will generate a dBase III file, since this format 

is widely supported by all database programs on the market. 

2.6.7 Compare Wells 

The Compare Wells function is useful for comparing selected wells. With this function 

the user can show wells that belong together although they are not located next to 

each other on the EliSpot plate in a presentation. To use this function select the 

desired wells by clicking once on them and then select the View Assay function. As a 

result you will get a view were all selected wells would be side by side. The user can 
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 print the wells or screenshot the window to get a JPEG file, which later can be used 

in Word or PowerPoint. 

 

 

2.6.8 Export in LIMS 

The AID EliSpot program can be linked to any lab software. Upon request we will 

customize this export possibility according to your needs. 

 

2.6.9 Show histogram 

The histogram function shows the various attributes of the spots such as spot size, 

spot intensity and cytokine secretion. In case you decide to use the histogram 

function in the whole plate layout click on the desired well to announce the software 

for which well you want to display the histograms. In any case a dialog box will 

appear which shows the histogram of the selected well. 

The contents of the histogram dialog box change whenever a different well is 

selected by activating its well view window, or by clicking on a certain well in the plate 

view. 
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As the ranges of the spot characteristics may be very different depending on your 

assay, it may be necessary to adjust the x-an y-scales of the histogram display. For 

this you have to click the More button since the right part of the dialog box is hidden 

per default. Once you have found your settings use the Save button to store these. 

2.6.10 Save Screenshot of window 

Save a screenshot of the window from anywhere within the program. This can be 

useful for presentation of your data. The screenshot will be saved as a JPEG file and 

can be imported in a different application (e.g. MS PowerPoint). 

 

 

2.6.11 Export to Power Point 

For publication reasons the software offers the possibility the export a document 

directly to MS Power Point. 
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2.7 The Window Menu 

 

 

The Window menu provides all the functions known from other programs based on 

MS Windows. You can also switch between two or more loaded EliSpot plates. 

 

2.8 The Help menu 

 

 

 

Under this menu point you will find some information on the EliSpot software you are 

working with as well as this user manual. In case of problems with the machine or the 

software an AID representative may ask you which software version you currently 

have. You will find this information under “About Eli..” where you will see the following 

box: 
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By clicking on AID support you will see the following information box which invites 

you to visit the AID EliSpot website and register as an AID EliSpot Reader user or 

simply get information on new products and updated versions of the EliSpot software. 
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The status dialog gives you hints for troubleshooting and general reference. This 

information will be used in the generation of audit trail and plate history files. 

 

 

 

2.9 Toolbars 

The most important functions of the software are provided as icons in the toolbar. 

Note that these toolbars differ depending on the view. If you have not used the 

system before, hold the mouse over the buttons in the tool bar. A description pops 

up, giving you some help. 

 

 

 

2.9.1 Toolbar of the whole plate view 

 

The leftmost icons are the standard icons for file input/output (I/O): 

 

 

 



 

AID EliSpot Reader Handbook V7.x 39/73 

Autoimmun Diagnostika GmbH  

Ebinger Str. 4 

D-72479 Strassberg 

Germany 

Tel. +49-743493640 

Fax  +49-7434936440 

www.aid-diagnostika.com 

 

  

The next group of  icons is based on program and user information 

 

From left to right: 

New document (plate) 

Open saved plate from disk. 

Save plate document. 

Print Document to standard printer or choose another printer. This will print the 

currently viewed plate on one page. 

 

 

  Eject plate 

  Login: gives a dialog where you type in your username and password 

  Manage EliSpot users 

  Change camera settings 

  Count settings 

 

Histogram Dialog box: Opens the histogram dialog box. For further 

information on histograms, please refer to the chapter Histograms. 

 

  Read, count and analyse a plate 

 

  Go: read and count plate. You may be required to name the plate first 

(protected mode) 

 

 

  countAID, automated detection of correct count settings 
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   Stop: stops whatever the program is doing. May require more than one 

click. 

  Plate properties: access (and edit) name, layout and history.  

 

  Quality control 

  Program Information: This will open a dialog box containing information 

about the software, like the copyright notice, release date and version number of the 

software you are currently using. 

 

2.9.2 Toolbar of the single well view 

 

 

From left to right: 

  Save well image 

  Print document: print current well/plate on one page. 

  Program information: This will open a dialog box containing information 

about the software, like the copyright notice, release date and version number of the 

software you are currently using. 

  Login 

  Manage users 

  Camera settings 

  Count settings 

  Histogram Opens the histogram dialog. For further information on 

histograms, please refer to the chapter Histograms. 
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Display Spot Outlines: There are three different modes to mark spots in the well view. 

The two (or three) outline options are mutually exclusive. When clicked, toggles the 

spot view mode to display an outline around each spot. When you click on the 

currently active display option again, it will be disabled, so that no outlines are drawn 

at all. Not available from saved plate! 

Display Spot Surface (left): Sets the spot view mode so that the area inside spots is 

colored. Not available from saved plate! 

Display Cluster Outlines (middle): Sets the spot view mode so that an outline is 

drawn around each cluster containing spots. Not available from saved plate! 

Display Crosses (right): Display Crosses to mark spots. A marker „X‟ can be 

displayed at the peak of each spot. The display of marker crosses can be enabled or 

disabled independently of the outline options, so that it is possible to combine any 

outline mode with or without marker crosses. If the color of the marker crosses or the 

outlines do not contrast well with the color of your assays, use the Change Color icon 

to open a dialog box that allows you to select a different color for either. Note that 

only crosses are visible when viewing a saved plate! 

 

   

  Add Markers: Allows you to manually add spot markers by clicking into 

the well image with the crosshair mouse cursor. This will show as a cross, but will not 

have an outline. 

  Erase Spots: Allows you to manually erase spot markers by clicking into 

the well. 

  Spot Information: Sets the spot information mode. Click on a spot with 

the question mark mouse cursor to display the spot's parameters in the status bar. 

This is the default tool. 
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a yellow flag shows up when the spot has been counted, red if it has been detected 

but not counted (e.g. because it is outside size or intensity threshold). 

  Change colors: Opens a dialog box that allows you to change the color 

of spot markers and outlines. 

  Zoom into the well image: Changes the cursor to a magnifier symbol. 

Click into the well image to zoom into it. To zoom back out click the right mouse 

button and select Zoom Out, or press the Esc button to view the well 1:1 again. 

 

  Comment: put in a comment specific for this well; will be displayed in 

the data.txt. Useful function for clinical trials; edited wells should be commented on. 
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SECTION 3: The AID EliSpot Reader in the Lab 
3.1 Set up the system for routine use 

This section explains how to set up and calibrate the AID EliSpot Reader System for 

use with one or more types of plates, create and manage count settings, set the 

camera. For this you need to be able to do all that was explained in the previous 

section. You should also be reasonably acquainted with the scientific background of 

the experiments: 

You need to 

 recognize common artifacts in EliSpot. 

 decide which spots you want to include or exclude in the analysis 

 decide on issues of quality management 

 

Getting good pictures of each well of an EliSpot plate is essential, since the actual 

plate will change over time and may fade considerably. Once a plate document has 

been stored on the hard disk or other media, it can be reanalyzed again and again 

without loss of information. 

First of all, the plate needs to be in focus. Focus is adjusted in the calibration dialog 

box with the buttons on the very right of the box. Note that in older systems focusing 

is done with the up-and-down switch on the Reader Unit. The optical set-up of the 

system has a very good depth of focus so that minor variations are not an issue. 

However, if a particularly bent plate is to be read, special precautions must be taken. 

To focus the Reader, insert plate, read plate, then choose a well near the center that 

has visible spots. Use the move-to command to view this well in the camera preview 

and focus camera. Different plate types have different layouts and the dimensions of 

the rims vary. Therefore the reading pattern must be adjusted to the plate type used 

in the stage calibration dialog. At this point, the diameter of the area of interest (aoi, 

or counting area) is also set. This has a major impact on the spot count, since in 

some assays most of the spots are found in the rim of the well; the user has to 

decide if they want to include these or not. AutoCenter is also controlled by the stage 

calibration. 

Camera settings should be adjusted to give a reasonably natural representation of 

the well. Color tone and contrast can be tuned; this will affect spot counts to some 

extent but most importantly the exposure („shutter speed“) must be set correctly. This 
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 determines the brightness of the picture and should be adjusted so that the 

background is not white but slightly tinted. If the pictures are too bright, smaller spots 

will be lost, if they are too dark, the detection of spots is overall lower. Since stage 

and camera settings are user-specific, it can be a good idea to have a different user 

login for each type of plate or assay. 

 

3.1.1 Calibrate the stage 

Each make and brand of EliSpot plate has a slightly different layout, so you need to 

calibrate the Reader to cope with this. You can calibrate the Reader for one or more 

types of plates and save the calibration in .ini files that control the plate layout, the 

size of the counting area and whether AutoCenter is on or off.. These .ini files allow 

you to switch from one type of plate to another without actually going through the 

process of calibration again. Stage.ini is used as default, i.e. when the program is 

started or a user is logged in, the stage.ini file is used as a default. This means that 

the type of plate that is most commonly used should be saved as stage.ini. 

 

 

Stage calibrations are user-specific. Make sure to log into the AID EliSpot program 

every time to work with your own calibrations. If you want to avoid having to load 

different stage settings, use more user logins so every type of plate has a login.  

Insert a plate, go to stage-calibrate stage, and click A1.  
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Click on  to center the counting area, i.e. put the dotted circle in the middle of 

the well. If you cannot see the dotted ring properly, use the button  to get better 

contrast. Use the control knob on the ruler to adjust the size of the image to actual 

millimeters; this is best dome with a graded object e.g. an AID master plate. Then 

use the arrows to physically center the well. Decide which size the counting area 

should be. In many assays, it may be a good idea to exclude spots around the rim. 

When using count settings from program version 2.5-2.9 (Algorithm B), you should 

always leave a rim free. Move to A12, use the arrows to center the well. then move to 

H12, use the arrows to center the well. After you have calibrated the stage to work 

with a certain type of plate, you should save the calibration data. Select the menu 

Stage->Save Calibration. A save as... dialog box will open where you can save the 

calibration under any filename. The default calibration file used by the software is 

called stage.ini. If you save a calibration as stage.ini, it will be used as the default 

calibration, and be loaded each time the software starts.  

If you want to use a saved calibration you can load it by selecting the pull down menu 

Stage->Load Calibration. This will open a Load Dialog box. The calibration file that is 

loaded will be activated immediately.  

From the calibration dialog, you can also access the camera dialog; you can 

customize the dialog by turning off the tooltips  

 

3.1.2 Adjusting the Camera 

Read a plate. Choose a well that is neither positive nor negative control, with some 

spots. Click right mouse click to get the context menu, choose move-to. Open the 

dialog camera settings  to tune the color response.  

Under some circumstances it may be necessary to use other camera settings than 

that provided by AID. If you need to change the camera settings first read a typical 

plate. Then choose a well with some spots that is neither a positive nor a negative 

control. Click right on that well (it should be not selected) to get the context menu and  

choose „Move-to“. An alternative is the „Move to“ in the calibration dialog box, which 

opens an illustrated plate where you will be able to select a well. Open the dialog 

camera settings to tune the color response. 
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 As a starting point use the AID default settings. If plate-to-plate variation requires 

tuning, only the exposure/shutter speed should be changed. Move the exposure 

setting slowly and watch for what happens in the live image. We suggest you to tune 

the exposure so that a homogeneous light grey background is visible in the wells.  All 

these settings are user specific and should be saved with the “Save” button. 

 

 

 

 

3.1.3 Focus 

Choose a well in the middle of the plate with some spots. Call up the calibration 

dialog and the camera preview and focus using the appropriate arrows in the dialog 

box. Save the changes. 
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 3.1.4 Count Settings 

Once the image has been taken, the count settings define what the spot count will 

be. It is essential that users understand count settings dialogs, handle and apply 

count settings correctly 

 

There is no easy way to find a 'gold standard' for what should be counted as a spot in 

an EliSpot plate. In, e.g., IFN-gamma plates, spots of different sizes appear, some of 

which are certainly produced not by T cells but by APC's. Some big spots may be 

made by agglomerates of cells - or not even by cells at all. You need to find an 

algorithm and cut-off that most closely match what you think is a spot, putting in your 

scientific understanding of the assay and its results. So depending on the 

experiment, count settings need to be adjusted. Counting spots follows a logical 

sequence. First spots are detected according to the algorithm used. This is found in 

the count settings dialog as „emphasis“. You may also use algorithms from previous 

software releases if you wish. All spots detected by the algorithm can be visualized 

by clicking on them (left mouse click) and holding down the mouse button. A colored 

flag shows up the spot description. 

To get to the count settings dialog, either hit the button in the tool bar in plate 

overview, or open a well, click right mouse click in the middle of the well, and select 

count settings from the context menu. This dialog box defines the algorithm and 

threshold values for size and intensity of those image elements the program should 

recognize as spots. Additional parameters may be included and depend on the 

software version used. 

The type of algorithm rules on whether a big spot is more likely regarded as a spot or 

a cluster of spots, also the calculation of spot size may differ between algorithms. 

Depending on the settings smaller spots are more readily detected or bigger spots 

are not so easily broken up into smaller spots. To decide on an algorithm, choose 

e.g. small as emphasis and hit apply. Repeat with tiny or big, decide which fits the 

spots you see most closely. 

All detected spots are then put through a threshold system where all those spots that 

do not meet requirements are discarded. Using the mouse ( -tool) these will 
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 show up with a red flag, not yellow. In the previous software releases various filters 

would then discard further spots. 

The user should specify a different color for representation of different count settings 

in the overview of the plate. 

Fluff filter: (only available with the 2.5-2.9 algorithms) When this feature is enabled, it 

searches the images of the wells for structures that resemble a hair or a fluff and 

removes image elements that are much bigger than spots such as cracks in the 

membrane. The area covered by such artifacts is mapped out in order to eliminate 

the counting of “false” spots. The Fluff Filter may under certain conditions disturb 

counting spots. The user has an option to enable or disable this feature. 

Background Enhancement: (only available with the 2.5-2.9 algorithms) This option is 

used for the enhancement of overdeveloped wells by application of contrast 

enhancements. This option can give misleading results in some cases, as small 

spots are obscured in strongly colored wells. This option can be disabled. 

Emphasis: In most cases the “small” setting gives the best results. The huge 

emphasis may lead to program crashes in some cases because it uses a lot of 

memory. 

Level of interpretation: In very dark wells, the spot count result may be low. This 

leads to a misrepresentation of results in Excel sheets. To counter this, you need to 

determine the level of saturation at which a well is still reliably counted. This will 

depend on the type of assay and very much on the type of color reaction you use. 

Put this value in the level of interpretation-dialog, well over this limit will be marked as 

not valid.  

 

3.1.5 Using Count Settings 

Count settings are user specific, user-defined and can be saved under any name, for 

example IFN-G, IL-4, IL-5, IL-10, Multicolor. New categories may be created 

depending on the needs of the users. Count settings can be selectively assigned to 

individual wells or groups of well in a plate. When no settings are chosen and applied 

to the plate or portions of the plate, default settings will be applied. Keep track of your 

count settings in writing. We suggest you use a table format like this for every user: 

 

Name, Emphasis Min/Max Min/Max Min/Max Level of Marker 
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 date Size Intensity Gradient Interp. color 

IFN-g 

4/4/2003 

small 20/2000 15/90 5/90 70% red 

IFN-g 

5/5/2003 

big 80/2000 18/90 5/90 70% red 

       

IL-4 

 

small 0/900 3/40 0/90 50% blue 

       

       

 

3.1.6 Tuning for White Plates  

White plates (i.e. (PVDF or Nitrocellulose plates with a white plastic chassis) can be 

run just as clear plastic plates, but they give less contrast between well bottom and 

well border. This can lead to a failure of the AutoCenter feature in some or even all of 

the wells in a plate. Tune the camera a little more brightly than for clear plates. If you 

still have problems with AutoCenter, redo the calibration very carefully and disable 

AutoCenter. Save this calibration as whiteplate.ini. You can also change the routine 

running of the system to first read (without AutoCenter) and save the plate, then run 

AutoCenter from the run menu, then run count. Save again when ready.  

3.1.7 Tuning for clear (ELISA-) plates 

We suggest you create a new user for this type of plate. See the following section for 

this. Insert plate. Go to menu file-options and choose invert image. Go to menu file-

stage calibration. Calibrate stage using a white background or with inverted image, 

disable AutoCenter, save calibration as clear.ini. Remove white background. Choose 

read plate from the run menu. Choose a well with visible spots, use the move-to 

command from context menu to move this well under the camera. Call up preview 

from camera menu. Focus the image correctelyt. Read plate again. Call up change 

camera settings from camera menu. Adjust settings for optimal contrast. Check 

focus. 

Go back to stage calibration. Calibrate stage again using a white background, leave 

AutoCenter disabled, save calibration as clear.ini. Read plate. Apply AutoCenter with 

the command in the run menu. Count plate. If this runs nicely, you can go back to 

stage calibration and enable AutoCenter. Save calibration again as clear.ini and then 
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 save again as stage.ini Adjust count settings. Count plate. Read and count plate with 

GO-button. Save as usually. 

(To return to regular plates, feed regular plate. Go to stage calibration. Measure 

apparent well width with a plastic ruler. Focus until back to previous apparent well 

width) 

 
3.2 Operate the system in a routine setup 
 

This section will explain how to run the system using pre-set settings safely. You 

need know how to use a windows-based computer: 

 Windows may require you to log in 

 You need to handle open, save and print dialogs. 

 You need to handle right and left mouse clicks.  

 You need to recognize file extensions (txt, xls, ini, plt) 

 You need to shut down Windows safely. 

3.2.1 Getting started: 

Switch on the Reader Unit. The light should come on after a few seconds. Do not 

switch off the Reader if you are only taking a short break as this shortens the life of 

the neon ring illuminator (light bulb). Wait 5-10 minutes for the neon light to reach 

maximum intensity. With the new LED lights, this is no longer necessary. Check if the 

monitor and printer are on. Boot the Computer/Control Unit with the large button on 

the front. Windows starts and may require a login from you. Find the AID program 

icon on the Windows Desktop  

 

and give it a double left mouse click. You may be required to log into the program 

with a name and a password. If you do not log in, you enter as “default" user. 
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What you get now is the program window with an empty EliSpot document open.  

 

3.2.2 Reading an EliSpot plate 

Hit the eject  button. Insert the plate into the Reader so that standing in front of 

the Reader, the well A1 is in the far left corner. Make sure the plate sits firmly on the 

stage. If you are using plates with a rubber foot, remove this before reading. 

If you need to handle data, edit flags, or use a template file, do this before you read 

the plate. 

Hit the -button in the tool bar. The Reader begins taking pictures, centers the 

well using AutoCenter and counts spots using the default count settings. The first 

well (A1) is automatically opened in a new window. Check if this looks all right, then 

close the well window. 

While the machine is running, open the dialog box properties with the button  in 

the tool bar. Enter a comment (type of plate, antibody pair, cells…). A name will be 

given to the plate when you save. 

If the plate looks too bright or too dark, choose a well with medium spot content, point 

the mouse to it and click right mouse. Use the move-to command, then select change 

color settings from the camera menu. Adjust Exposure/shutter speed to give a 

reasonable image, then redo read and count. If you do this often, put the exposure 

value in the plate comment! 

If the wells look off-center, there may be a problem with the stage calibration. Check 

if the plate is inserted properly! Then do a stage reset from menu file-> stage-> stage 

reset and read again. If this fails, you may have to load a different calibration or do 

the stage calibration again. 
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 When the reading and counting is finished (look at the status bar at the bottom) save 

the document: hit the save button  in the tool bar or choose save from the file 

menu. A dialog comes up that says where the plate is being saved and under what 

name. 

Hit the print button  in the tool bar. A page is printed that shows the whole plate 

with each well as a small image and usually with the count result in the lower left 

corner. This is your immediate record of the EliSpot plate which you should file away. 

Eject plate using the  button in the taskbar. 

 

At this point you can also export data either into a text file or into MS Excel. To do 

this, go to the data menu and choose view data to look at the text file. This is a very 

compact way of having your EliSpot results on one page. To export data to Excel, 

chose open in Excel in the data menu. Excel opens and the data appear 

automatically in a new document with several spreadsheets. Close Excel‟s program 

window. A dialog appears that asks you to save the data. Enter a name and hit save. 

(Tip: If you highlight and copy ctrl+c the name of the plate when you enter it into the 

save dialog of the EliSpot program, you can now put it into this save dialog with 

ctrl+v). 

Close the document window in the AID program. If you have more plates to read, 

open a new, empty document from the file menu. Repeat as before. 

 

3.2.3 Using selection 

Point to a non-selected well and click right mouse click. You get a pop-up menu (i.e. 

a list of things you can do). Try this again with a selected well: a different list of things 

pops up.  

If you want to do something to some wells but not to all, you can use the selection 

feature. Go to the selection menu. It gives you three things you can do: select all 

wells; clear selection, and invert selection. You can also select/de-select all wells by 

using keyboard commands ctrl+a and ctrl+c. If you want to select only some wells, 

click on a well (left mouse click) to select and again left mouse click to remove the 
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 selection. The selected wells are blue, non-selected wells are white in background 

color. You can also hold down the mouse button and pass over several wells. If you 

have now selected some wells, you can go back to the selection menu to invert the 

selection. You can also do this with the keyboard command ctrl+i.  

If you only want to read the right half of the plate because the rest is empty, pass the 

mouse over all wells on this side of the plate while holding down the left mouse click. 

Then point to one of the selected wells and hit the right mouse click. A list pops up. 

Choose Read and Count selection. The Reader will only take a picture of the 

selected wells and count them. 

3.2.4 Using different Count Settings 

You need to handle preset count settings which you have to apply to a whole plate or 

part of a plate. Select either the whole plate of part of the plate and point to the 

selected part. Hit right mouse click and go to select count settings… where a list of 

available count settings pops up. Choose one and click it left mouse click. Count 

settings are color-coded, so the wells which now have the chosen count settings are 

labeled with a little colored square. You can now go on to put count settings to the 

rest of the plate. Either clear the selection and select another portion of the plate, or 

use the invert selection feature. 

Tip: if you use different count settings put to the appropriate wells it will help you to fully document 

your results. 

You can also go back to previously saved plate document through the open dialog. 

Locate the plate folder and open the plate document e.g. name.plt with a double left 

mouse click. 

If you perform any changes, you may want to save the plate under new name with 

the save as command in the file menu. Please note that to conserve disk space 

some features of the wells are not saved. Number and location of the spots per well 

is saved but not the spot outlines. If you export data from a saved plate, some 

measurements will be missing in the text or excel documents unless you re-count the 

plate. 

Note on document formats: Usually images are stored as jpg -files which gives a good compromise 

between quality of the images and rate of compression. However, jpg compression is not loss-less, i.e. 

the saved image is slightly simplified compared to the original image taken. This may lead to tiny 

variations of spot count between the initial count result and a recount. 
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 If you want to avoid this, use bmp or tiff format for the storage of image data, at the cost of having 

rather large files. Data acquired in clinical trials should be saved in tiff or bmp format. 

 
 
 
 
 
3.3 Administrate the AID EliSpot Reader System in a Clinical Trial 

 

For this you need to handle securely the setup and running of the AID EliSpot 

Reader System. Also you must be aware of the regulations that apply to your work 

such as FDA requirements etc. The AID EliSpot Reader System complies with a 

number of international standards such as 21CFR part 11. 

The AID EliSpot Software after version 4.0 offers special features for clinical trials. 

First use the “default” login to set up the Reader for your type or types of plate and 

assay, edit stage, camera and count settings as needed. Then set up the user 

management. 

Note: passwords should be 8 digits, letters and numbers only. 

For this we suggest you create an “administrator” login with password access and 

edit this login to have administrator privileges. Log in as “administrator”, then edit the 

“default” login so as to remove user management privileges. In the user management 

dialog, check the boxes for login at startup and protected mode. Create a new login 

called e.g. “trial” for the user who is going to run the Reader (with password). As 

always, the new user gets the same settings as the “default” user so you need not go 

over count, camera and stage settings again. Edit the “trial” login to have no rights at 

all (or consider allowing to tune camera). Define “trial” as default login. You can also 

now delete the “default” user. Create another login called "master" to read an AID 

EliSpot Master plate, e.g. Master Plate 33. 

It could be a good idea to have another login called “test” which should be edited to 

have all rights but not the user management. This can later be used if someone 

wants to test variants of settings etc without messing up the trial settings. If you are 

using a master lot, make a login for this, too, as this will require specific count 

settings and stage calibration. 

Protected mode: this ensures traceable results. On the command read and count 

(Go-Button) the program first asks for a name of the document; after reading and 



 

AID EliSpot Reader Handbook V7.x 55/73 

Autoimmun Diagnostika GmbH  

Ebinger Str. 4 

D-72479 Strassberg 

Germany 

Tel. +49-743493640 

Fax  +49-7434936440 

www.aid-diagnostika.com 

 

 counting, the document is automatically saved to hard disc. The plate folder contains 

a duplicate set of numerical data. 

The “trial” user can not change the original count result of a saved plate and save the 

data in the same folder. If the “trial” user wants to recount from a saved plate, they 

can not save the plate under a new filename. The login permits, however, to recount 

with changed settings, and care must be taken not to print or to export to excel or 

data.txt at this point. 

It is good practice to put a comment to wells that have been edited by the supervisor 

in the well properties dialog. This is available from the button in the tool bar. 

History: The history file is an automatically generated file that cannot be manually edited. Every 

session with the plate is recorded and can be viewed from the plate properties dialog. 

The trial supervisor should only accept data in whichever format if the following 
requirements are met: The data were acquired under the trial or administrator login; 
data are consistent between data.txt, excel sheet, dbf file, printout and raw data on 
hard disk. This can be verified easily by comparing a data set to the history file of the 
plate document. You can export the plate history file to Notepad in order to search or 
print it.
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Section 4: Features of different AID EliSpot Systems  
4.1 iSpot Reader IFL 
The iSpot Reader is a combination of a traditional enzymatic Elispot reader and a 

fluorospot reader. The ispot software is optimized to read two or three different 

fluorescent dyes.    

Switch between one-color (enzymatic) and two/three-color (fluorescent) mode: 

First turn the LED light off and switch the Xenon lamp on. Next go into "tools-options-

data aquisition - optics" and press the button for the "two-color mode".  

 

 

Select the correct filter set and press OK. As a consequence the reader will take two 

pictures from each well, thereby changing the fluorescent filter above every well. 

since two pictures are taken, the software provide the possibility to select two 

different count settings for each well.  

 

It is always a good idea to establish an user working only with fluorescent assays in 

the user management. AID has predefined such an user named "IFL" or "Fluoro". If 

you need more details please refer to "How to operate the iSpot system", which you 

can find in the help menu of the software. 

 

 

4.2 Viruspot Reader VSR 

In contrast to the reader type “Classic” and “iSpot” the Viruspot Reader can also cope 

with plates formats other than 96 wells. Therefore the main difference to the other 

readers can be found in the calibration dialog, which is a bit more comprehensive 

compared to the normal dialog box. 
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First of all you should select the plate type (6/12/24/48 or 96 well plate) in the combo 

box at the top of the dialog box. In a second step you have to resize the image by 

using the arrows for „O“ (objective ,on the left of „A1“) and focus to the sharpest 

position with arrows for „C“ (camera). Having done this follow exactely the steps 

described in the "How to calibrate the stage" file or in the Calibration section of this 

handbook. 

 

Since the ViruSpot is designed also to read virus plaques the software provides 

additional count algorithms, which you can select in the count-settings dialog box in 

addition to the global algorithms A-C. 

If you need more details please refer to "How to operate the ViruSpot system", which 

you can find in the help menu of the software. 

 

4.3 Robotic system ELRob 

The robotic system of the AID readers can take 30 plates in one run. Calibration of 

the system is slightly different from the other readers. 



 

AID EliSpot Reader Handbook V7.x 58/73 

Autoimmun Diagnostika GmbH  

Ebinger Str. 4 

D-72479 Strassberg 

Germany 

Tel. +49-743493640 

Fax  +49-7434936440 

www.aid-diagnostika.com 

 

 
 

Section 5: Results  

5.1 Results at a Glance 

The immediate result of your EliSpot assay is a folder with images of the EliSpot 

wells. In the AID EliSpot Software these are displayed as thumbnails in the plate 

overview, cropped to the outline of the counting area that was specified in the stage 

calibration.  

The AID EliSpot Software analyzes the wells of an EliSpot plate and presents you 

with a range of different measurements: Spot number per well, of course. Spot 

intensity measured in brightness units from 0 (White) to 255 (Black). Overall spot 

surface in a well is measured in square millimeters (mm²), i.e. the area occupied by 

spots recognized and counted by the software. 

Spot Surface (Area) of single spots is measured in square 1/100th millimeters (0.01 

mm)². One square millimeter equals 10.000 square 1/100th millimeters. To obtain 

accurate measurements, you may want to correct for variations in the optics (see 

next subsection). Well saturation gives you a percentage result where 100% equals a 

black area in the counting area, 0 % all white. This helps identify overdeveloped wells 

that will not be counted accurately. 

First of all, you get a count result of spots per well in the lower right corner, i.e. the 

number of spots that were counted using the relevant count settings.  

 

 

Usually people publish EliSpot results as numbers of spots (or SFU, spot-forming 

units) per million cells in the assay. A totally different way of looking at your EliSpot is 
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 the "Cytokine" value. The cytokine secretion is measured in a virtual unit that is 

equivalent to the surface in (0,01 mm)² multiplied by the intensity of the spot. This 

value in our experience reflects cytokine production more closely than number of 

spots. However, there is no canon of peer reviewed papers published yet to validate 

this.  

Whichever way you look at your results, the settings you use will show in the figures; 

finding a rational for the settings you use may take up a lot of effort; however, the 

ratio of e.g. test to negative control or test 1 to test 2 should be fairly stable under 

different modes of interpretation. 

 

 

5.2 Pixels per Millimeter 

It is important to know how many pixels are used to represent a spot. Electronic 

images are composed of individual pixels (picture elements), where each pixel has its 

own color but all pixels have the same size. Higher resolution images- more pixels 

per image- give a more accurate recognition and calculation of spots, but the image 

files are larger and image analysis is not as fast. Lower resolution images are 

processed faster and take up less space on your hard disk or other media. Please 

note that the quality of the image is not determined by the resolution alone but also 

by the amount of “noise” in the picture, the ability to distinguish dark on dark colors or 

very bright on bright colors. 

To determine the size of the well as it is represented in the Reader's image, you can 

use any graded object such as an AID Master plate, a ruler or graded paper. Take a 

picture (save plate document folder, retrieve image from folder through Windows 

Explorer) and load this into an image processing software such as Adobe Photoshop. 

Crop the image to include only a defined bit of the image, e.g. the diameter of the 

well or one millimeter of a ruler. Determine the size of the image in pixels.  

Several parameters determine the pixel/millimeter ratio. Camera resolution has the 

greatest impact. The camera's CCD chip determines the maximum number of pixels 

the camera can produce. AID EliSpot Readers use different cameras with different 

CCD chips. See the separate documentation of the camera for details. The optics 

used for video cameras are usually defined by the size of the CCD chip (e.g. 1/3") 
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 and the desired distance between optics and object (EliSpot plate). The optics 

therefore determines how many millimeters of the well are reflected on the CCD chip. 

Focus plays a role, too. All Neon-Ring AID Readers have good depth of field, which 

means a spot will appear to be in focus even if the membrane is a bit below or above 

the ideal plane of focus. However, the distance between the optics and the well has 

an influence on the well's apparent size! 

                                             

under-focus                        focus                                          over-focus 

 

The image is then cropped by the EliSpot software since most chips have an oblong 

image size while the EliSpot wells, being round, require a near square image. 

small screw in the camera's side. This is not possible in the new Marlin cameras. 

 

5.3 Errors 

This section explains how errors occur in automatic counting of EliSpot plates and 

how to handle them. Reading EliSpot plates by eye or with the help of a dissecting 

microscope takes about one hour per plate, more if there are many spots to be 

counted. Counting by eye has the advantage that the researcher or operator usually 

identifies spots intuitively and with good accuracy. However, it is very hard to define 

by eye a threshold for size and intensity for spots; in our experience, results from 

"manually" counted plates vary by 30% between counts. Also it is very hard to 

exclude bias from the counting. Automated systems such as the AID EliSpot Reader 

System can analyze a plate very rapidly but not without errors. 

Typical Problems 

As a general rule, a well that you cannot precisely count by eye cannot be more 

precisely counted by the Reader. You may need to fix some problems in the assay 

rather than in analysis. 
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 If the well is highly saturated, small spots are obscured by the background color of 

the well or are caught up in bigger spots. AID EliSpot software offers a special 

function for this: in the count settings dialog, you can determine the maximum 

saturation of the well which in your experience is still accurately counted. Wells 

darker than this will be marked in the plate overview with red background color and 

with the comment "not valid" in the excel sheet. If the positive control wells of an 

EliSpot plate are very dark, this does not constitute a problem; if the "test" wells are 

too dark, this may mean that your result for these is "+++" rather than a specific 

number of spots per well. 

Spot counting is more accurate if spots are sharply outlined rather than blurred. This 

is dependent on the type of assay, most prominently on the quality of the coating. 

High-contrast spots in wells give better reproducibility. 

 

Wells with uneven distribution of spots or with patches of confluent spots are 

particularly difficult to count. 

Another common problem of EliSpot analysis are dust particles or hairs in the wells. 

These will often result in extra spots. We recommend checking the plate in overview 

mode to detect apparently overestimated spot results and to eliminate extra spots by 

hand  

Precision of Spot Analysis 

To perform a detailed analysis of a single spot, this spot must be represented by a 

minimum of 5-7 pixels across to perform any calculations. This means that smaller 

spots will be detected but only spots of this size or bigger are accurately described in 

terms of gradient or color. Determine this value for you own machine. 

 

Including or Excluding the Rim 

Problems in the analysis of EliSpot wells often arise in the rim of the well. This is a 

feature of some assay types and can lead to misrepresentation of EliSpot results. If 

you regularly have more spots in the rim than in the center or confluent spots in the 

rim of the well, we suggest you calibrate the stage so as to exclude the rim. If you are 
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 using Algorithm B -type count settings, you must always do this. Do not use the filter 

white rings. 

  

 Determine the Reproducibility of the Count Result 

Read and count the same plate taking into consideration the above mentioned 

points. Do at least three counts, more for better accuracy, and compile these in e.g. 

Excel to get an estimate of run- to- run variation of the count result. We cannot give a 

figure for this as it varies with the type and quality of the assay under consideration. 

You will sometimes find that the software has counted or not counted a spot where 

you would have decided differently by eye. These errors will account for a small 

percentage of the count result which is a small price to pay for the speed of the 

analysis. 

Recounting from saved plates should not- but cannot be warranted to- give no 

variation; however, the original count result is based on the camera's raw image, and 

if the image was saved in jpg format it will be subtly different. This may account for an 

insignificant change in count result between first count and recount even under the 

same count settings. 
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Section 6: Troubleshooting 
If the system does not work as it should, run down Windows, switch off 

computer, reboot!  

 

Reader does not start: 

Check power supply; check fuse in the Reader (phone AID tech support). 

Reader light comes on and goes out again after a short while: 

neon ring illuminator dying. Replace (phone AID tech support). 

 

Reader will not run after Windows is reinstalled 

Reader Unit cannot run if Windows was reinstalled or updated by customer. Send 

Computer/Control Unit back to AID for reinstallation with all software media and 

license numbers supplied. 

 

Camera failure after either Reader Unit or Computer/Control Unit was replaced: 

The Sony camera is individually recognized by the Camera driver software. When the 

camera is connected to the Computer/Control unit for the first time, you may have to 

reinstall the driver. Get specific instructions from AID (although this is not really 

difficult). 

 

Computer will not boot: 

Check power supply. Phone AID tech support. 

 

Software update does not run the Reader System 

After installation of a software update it may be necessary to check the hardware 

settings in the menu file--> options. Proceed by trial and error or phone AID. If you try 

to update a Windows NT system, contact AID! 

 

Computer seems slow: 

Check if system disk (C:) is full. If less then 500 Mbytes free space remain, Windows 

will be slow. Check with network administrator if Computer/Control Unit has been 

networked. Sometimes networking seems to slow down the computer to a point 
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 where work becomes impossible. In that case, have the software reinstalled by AID; 

you may ask for a dual boot to operate the Reader and access the net alternatively.  

 

Stage will not move or makes weird noises:  

See if stage is secured with plugs or screws. Check if cables are properly in their 

sockets. If problem persists, phone AID tech support. 

 

The workaround for bent plates 

Put in the bent plate and push down the left half. Select the wells on the left half. 

Read and count selection. Eject plate put don‟t take it out, just push down the right 

side. Hit ctrl+i and repeat read and count selection. Save as always 

 

If you have trouble reading or interpreting EliSpot plates, test read a plate and send 

us the plate folder by email. Please do not read all wells for this as a plate document 

is min 5 Mbytes and this rapidly clogs up our mail server. We will get back to you with 

suggestions. 
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SECTION 7:  Technical Specifications of AID Reader 
Systems 
 
 
 
ELR07 

 

 

 

 

 

 

 

 

 

Hardware   

PC system  High-end PC with Intel Core2Duo processor, 19'' screen, color printer 

Illumination  Evenly spread, long life LED ring illumination 

Camera resolution and control  5 Megapixel, color, firewire-connected 

Power input  250 mA @ 230 V/ 500 mA @ 110V 

Footprint  430x430x260 mm (Peripherals not included) 

Software   

Operating system  Windows 7 Professional (32/ 64 bit)  

AID Software  AID EliSpot 6.x  

MS Office Version  MS Office 2007 Professional 

Burning Software  Nero 9.x 

Additional software solutions included  AID EliStat, AIDiagnostics  

Plate formats and assays  

Applicable assays  EliSpot, Viral Plaque Assays, Neutralization Assays in 96-well plate format 

Plate formats  96-well plates (any manufacturer) 

Certifications/ Validations   

DIN EN ISO 13485: 2003, DIN EN 980  Yes 

DIN EN ISO 14971, FDA 21 CFR Part 11  Yes 

Miscellaneous  

No. of different counting algorithms  12  

Analysis of multi-cytokine secretion assay  By color 

Time demand for complete analysis  ≈2 min for a 96-well enzymatic plate 

Warranty    2 years warranty, service contracts available 

Delivery schedule  3-5 weeks after ordering 

Important note 
Self installation. Online user training. Price does not include installation 
 or on-site user training. May be purchased separately. 
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 iSpot / ELR07 IFL 

 

Hardware   

PC system  High-end PC with Core2Duo processor, 19'' screen, color printer 

Fluorescent filter set and control  2 narrow-banded filters on board, 4 position filter/ LED changer 

Fluorescent imaging  "FluoroAID", AID's patented well overlay technology 

Illumination  Evenly spread, long life LED ring and external Xenon light 

Camera resolution and control  2 Megapixel, optimized for fluorescence imaging, firewire-connected 

Power input  350 mA @ 230 V/ 700 mA @ 110V 

Footprint  430x430x360 mm (Peripherals not included) 

Software   

Operating system  Windows 7 Professional (32/ 64 bit)  

AID Software  AID EliSpot 6.x 

MS Office Version  MS Office 2007 Professional 

Burning Software  Nero 9.x 

Additional software solutions included  AID EliStat, AIDiagnostics  

Plate formats and assays  

Applicable assays 
 EliSpot, FluoroSpot, Viral Plaque Assays, Neutralization Assays on 96-well plates 
 Others after consultation 

Plate formats  96 well plates (any manufacturer) 

Certifications/ Validations   

DIN EN ISO 13485: 2003, DIN EN 980  Yes 

DIN EN ISO 14971, FDA 21 CFR Part 11  Yes 

Miscellaneous  

No. of different counting algorithms  16  

Analysis of multi-cytokine secretion assay  "FluoroAID", AID's patented well overlay technology 

Time demand for complete analysis  ≈3 min for a 96-well enzymatic plate, ≈10 min for a FluoroSpot plate 

Maximum number of fluorescent filters  3 

Warranty  2 years warranty, service contracts available 

Delivery schedule  3-5 weeks after ordering 

Installation & on-site training  Included in quoted price 
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 VSR07 

 

 

  

Hardware   

PC system  High-end PC with Core2Duo processor, 19'' screen, color printer 

Fluorescent filter set and control  3 narrow-banded filters on board, 8 position filter/ LED changer 

Fluorescent imaging  "FluoroAID", AID's patented well overlay technology 

Illumination  Evenly spread, long life LED ring and external Xenon light 

Camera resolution and control 
 5 Megapixel, optimized for fluorescence imaging, firewire-connected 
 2 Megapixel (6, 12, 24, 48 and 96-well applications), firewire-connected 
 

Power input  350 mA @ 230 V/ 700 mA @ 110V 

Footprint  430x430x360 mm (Peripherals not included) 

Software   

Operating system  Windows 7 Professional (32/ 64 bit)  

AID Software  AID EliSpot 6.x 

MS Office Version  MS Office 2007 Professional 

Burning Software  Nero 9.x 

Additional software solutions included  AID EliStat, AIDiagnostics  

Plate formats and assays  

Applicable assays 
 EliSpot, FluoroSpot, Viral Plaque Assays, Neutralization Assays, Cell Counting, 
 Cell Viability Tests, Apoptosis Assays, HLA-screening, others after consultation 

Plate formats  6, 12, 24, 48 and 96-well plates 

Certifications/ Validations   

DIN EN ISO 13485: 2003, DIN EN 980  Yes 

DIN EN ISO 14971, FDA 21 CFR Part 11  Yes 

Miscellaneous  

No. of different counting algorithms  16  

Analysis of multi-cytokine secretion assay  "FluoroAID", AID's patented well overlay technology 

Time demand for complete analysis  ≈3 min for a 96-well enzymatic plate, ≈10 min for a FluoroSpot plate 

Maximum number of fluorescent filters  7 

Warranty  2 years warranty, service contracts available 

Delivery schedule  4-6 weeks after ordering 

Installation & on-site training  Included in quoted price 
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iSpot Reader Spectrum  
(ELR078 IFL)  
 
 
 
Hardware   

PC system  High-end PC with Core2Duo processor, 19'' screen, color printer 

Fluorescent filter set and control  3 narrow-banded filters on board, 8 position filter/ LED changer 

Fluorescent imaging  "FluoroAID", AID's patented well overlay technology 

Illumination  Evenly spread, long life LED ring and external Xenon light 

Camera resolution and control  5 Megapixel, optimized for fluorescence imaging, firewire-connected 

Power input  350 mA @ 230 V/ 700 mA @ 110V 

Footprint  430x430x360 mm (Peripherals not included) 

Software   

Operating system  Windows 7 Professional (32/ 64 bit)  

AID Software  AID EliSpot 6.x 

MS Office Version  MS Office 2007 Professional 

Burning Software  Nero 9.x 

Additional software solutions included  AID EliStat, AIDiagnostics  

Plate formats and assays  

Applicable assays 
 EliSpot, FluoroSpot, Viral Plaque Assays, Neutralization Assays on 96-well plates 
 Others after consultation 

Plate formats  96-well plates (any manufacturer) 

Certifications/ Validations   

DIN EN ISO 13485: 2003, DIN EN 980  Yes 

DIN EN ISO 14971, FDA 21 CFR Part 11  Yes 

Miscellaneous  

No. of different counting algorithms  16  

Analysis of multi-cytokine secretion assay  "FluoroAID", AID's patented well overlay technology 

Time demand for complete analysis  ≈3 min for a 96-well enzymatic plate, ≈10 min for a FluoroSpot plate 

Maximum number of fluorescent filters  7 

Warranty  2 years warranty, service contracts available 

Delivery schedule  4-6 weeks after ordering 

Installation & on-site training  Included in quoted price 
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AID iRob Reader            
(ELROB07 IFL)  
 

 

 

Hardware   

PC system 
 High-end PC with Core2Duo processor, 19'' screen, color printer 
 2 TB external hard disk, UPS 

Fluorescent filter set and control  3 narrow-banded filters on board, 4 position filter/LED changer 

Fluorescent imaging  "FluoroAID", AID's patented well overlay technology 

Illumination  Evenly spread, long life LED ring and external Xenon light 

Camera resolution and control  2 Megapixel, optimized for fluorescent imaging, firewire-connected 

Power input  350 mA @ 230 V/ 700 mA @ 110V 

Footprint  760x540x460 mm (Peripherals not included) 

Software   

Operating system  Windows 7 Professional (32/ 64 bit)  

AID Software  AID EliSpot 6.x 

MS Office Version  MS Office 2007 Professional 

Burning Software  Nero 9.x 

Additional software solutions included  AID EliStat, AIDiagnostics  

Plate formats and assays  

Applicable assays  EliSpot, FluoroSpot, Viral Plaque Assays, Neutralization Assays on 96-well plates 

Plate formats  96-well plates (any manufacturer), up to 30 plates per run 

Certifications/ Validations   

DIN EN ISO 13485 : 2003, DIN EN 980  Yes 

DIN EN ISO 14971, FDA 21 CFR Part 11  Yes 

Miscellaneous  

No. of different counting algorithms  16  

Analysis of multi-cytokine secretion assay  "FluoroAID", AID's patented well overlay technology 

Time demand for complete analysis  ≈3 min for a 96-well enzymatic plate, ≈10 min for a FluoroSpot plate 

Maximum number of fluorescent filters  3 

Warranty  2 years warranty, service contracts available 

Delivery schedule  4-6 weeks after ordering 

Installation & on-site training  Included in quoted price 
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SECTION 8:  Glossary, TRADEMARKS 

8.1 Glossary 

AOI 

Area of Interest; counting area. This is a standard term in image processing. It means 

the area in an image that is of interest for image processing functions. In the EliSpot 

software, this is the circular area the marks a well‟s ground surface. Area outside this 

AOI will be ignored by all image processing functions. 

 

AutoCenter 

An image analysis function to automatically adjust the AOIs to fit the EliSpot wells. 

 

CCD 

Charge Coupled Device. The name of the light sensitive chip inside a video camera. 

 

JPEG 

Joint Photographic Expert Group. This is a standard for lossy compression of 

photographic images. Saving the well images in JPEG format reduces the space 

consumption by a factor of 5 to ten, depending on the selected compression level. 

The drawback is that this type of compression is lossy, meaning that the expanded 

images will not be identical to the original images. If you need to store the well 

images without any loss of image quality you need to select BMP or TIFF as output 

file format. 

 

MO Disk 

Magneto Optical Disk. A reliable media for storing huge quantities of data. One MO 

disk can hold more than 600 MB of data, that is about as much as a CD. Using image 

compression, one disk can hold up to 60 EliSpot plates. MO disks are not commonly 

used any more because they are not very fast and rather expensive; however, they 

give reliable long-term storage of data. 

 

Pixel 
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 A video image consists of a specific number of individual picture elements. These 

single points are called Pixels. In the AID EliSpot Reader System, one Pixel has a 

size of approximately 0.01 millimeter. However, the exact representation of a well in 

so many pixels must be individually determined and varies with the plane of focus. 

 

FireWire  

A port/cable system that works very much like USB, but much faster. Technically it is 

based on SCSI. 

Patches or service packs 

Microsoft issues patches to fix bugs in their software releases. These are usually 

obtained through internet download; they come as .exe files that self-install into the 

system or office program. Please read the manual carefully before installing any of 

these or phone AID technical support. 

 

8.2 Trademarks 

Windows NT™, Windows 2000™, Windows XP, DirectX™, ActiveX™, Windows 

Script, Windows Scripting Host, and Microsoft® Excel™ are registered trademarks of 

Microsoft Corporation. Adobe and Photoshop are trademarks of ADOBE, Inc. Intel® 

and Pentium® are registered trademarks of Intel Corporation; MMX™ is a trademark 

of Intel Corporation. 
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SECTION 9:  
WARRANTY, VALIDATION, CONTACT INFORMATION 

 

9.1 Warranty: Terms and Conditions 

These terms and conditions apply only if you are dealing with AID directly. If you are 

purchasing from a distributor or through an agent or other third party, inquire about 

their terms. Terms and conditions quoted to you take precedence over those stated 

here. If any clause of these terms should be void under applicable law, the remainder 

will not be void. Warranty is granted on all parts for two years from the receipt of the 

equipment at the clients‟ facility. Coverage includes all parts and labor including 

shipping and handling from and to the clients‟ site to AID. Installation of software 

without the written consent of AID will void the warranty on the Computer/Control 

Unit. Warranty can be suspended if payment of the equipment is incomplete three 

months after installation. Warranty will be void if  repair is attempted without written 

authorization by AID. Warranty does not cover the light bulb, the hard drive and any 

exchangeable computer media supplied. The manufacturer can not be held 

responsible for any of the following: any damages incurred through the use of this 

equipment; down time encountered during repair cycles; data loss due to failure of 

the equipment. 

 

9.2 Validation on the AID EliSpot Reader System 

CE Since 1998 AID's QM (Quality Management) complies with the German Law on 

Medical Products (Medizinproduktegesetz). AID Products carrying the CE sign can 

be sold without further validation anywhere in the EU (European Union). 

GMP is as a standard included in the German law on Pharmaceutical products 

(Arzneimittelgesetz) with which we comply. 

DIN EN ISO 9001 Our QM System complies with the ISO 9001 since 1998 which was 

superseded by the DIN EN ISO 13485, year 2000 edition. DIN EN ISO 60601-1-4: 

This is the validation for Software and Hardware for medical products. This 

internationally accepted norm is largely identical to FDA requirements. 21CFR Part 

11. These are the specification for equipment used in clinical trials. This stresses 

requirements such as data organization, audit trail and electronic signatures. We 

meet these requirements since the 3.0 AID EliSpot Software update. 
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 All audits were carried out by the certifying organization DQS (Deutsche Gesellschaft 

zur Zertifizierung von Managementsystemen mbH). 

 

9.3 AID Contact Information 

 

Manufacturer:  

AID Advanced Imaging Devices GmbH  

Ebinger Str. 4  

72749 Strassberg  

GERMANY  

VAT Number  DE 144847 487  

CEO Gerlinde Schöllhorn 

Registergericht Stuttgart, HRB 40725  

Tel.: +49 7434 9364 0,   

Fax: +49 7434 9364 40  

Webside: www.aid-diagnostika.com  

Webside: www.elispot.com 

e-mail: info@elispot.com  

 

Technical support:  support@elispot.com 
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